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Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced
parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
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care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or
d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user for safe operation and to keep the
product in a safe condition.

To safely perform service on this product, additional information is provided at the end of this section. (See page v,
Service safety summary.)

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product
or any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition
to the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or
adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location.
Do not position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all
times to allow for quick disconnection if needed.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.

The measuring terminals on this product are not rated for connection to mains or Category II, III, or IV circuits.
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Important safety information

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open.
Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of
the product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not
use probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Replace batteries properly. Replace batteries only with the specified type and rating.

Recharge batteries properly. Recharge batteries for the recommended charge cycle only.

Use proper fuse. Use only the fuse type and rating specified for this product.

Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a
warm environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product
so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects
into any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display
and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use
may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress
injuries.

Use care when lifting and carrying the product. This product is provided with handles for lifting and carrying.
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Important safety information

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of
rendering first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains
power before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect
power, remove battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing
components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.
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Important safety information

Terms in this manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and terms on the product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the
potential hazards and any actions which have to be taken to avoid them. (This symbol may also be used to
refer the user to ratings in the manual.)

The following symbol(s) may appear on the product:
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Compliance information

Compliance information

This section lists the safety and environmental standards with which the instrument complies.

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

U.S. nationally recognized testing laboratory listing

UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
1: General Requirements.

Canadian certification

CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory
Use – Part 1: General Requirements.

Additional compliances

IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
1: General Requirements.

Equipment type

Test and measuring equipment.

Safety class

Class 1 – grounded product.

Pollution degree descriptions

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

Pollution degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

Pollution degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.
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Compliance information

Pollution degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

Pollution degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution degree rating

Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location use only.

Measurement and overvoltage category descriptions

Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following
categories (see specific ratings marked on the product and in the manual).

Category II. Circuits directly connected to the building wiring at utilization points (socket outlets and similar points).

Category III. In the building wiring and distribution system.

Category IV. At the source of the electrical supply to the building.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a
measurement category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating

Overvoltage category II (as defined in IEC 61010-1).
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Environmental considerations
This section provides information about the environmental impact of the product.

Product end-of-life handling

Observe the following guidelines when recycling an instrument or component:

Mercury notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due to
environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling Central
Web page (www.eiae.org) for disposal or recycling information.
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Preface

Preface

The Tektronix BitAlyzer Bit Error Ratio Analyzers support serial data interfaces from 100 MHz to 1.5 GHz (BA1500) and
1.6 GHz (BA1600).

The BitAlyzer Analyzer combines a test pattern generator and error detector with advanced physical layer tests in one system.

The Generator produces a controlled data stream. When a clock is provided (either the internal clock synthesized by the
BitAlyzer, or an external clock), data bits of a user-selected data type will be generated. The data pattern can be one of the
predefined pseudo-random bit sequences (PRBS) installed in the Generator memory, or a user-created pattern.

The Error Detector compares the incoming data with a copy of the original. Every bit error is tracked with an accuracy 1,000
times deeper than a sampling oscilloscope. The location of errors can be correlated with the eye diagram, pattern sensitivity,
error free interval, block errors, and other analysis methods. The error detection data can be stored for later analysis.

Documentation
Product Documentation

For information about: See these resources:

Initial Setup This Quick Start User Manual

Operation and Analysis Online Help installed on instrument

Remote Control Remote control command listing (available as a PDF file on instrument hard disk drive)
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Installation

Installation

The BitAlyzer Analyzer is carefully packaged for shipping to ensure against damage. Nonetheless, damage or loss may
occur, and so we recommend you verify the contents of the shipping container, inspect the unit mechanically, and perform
a quick operational test when you first receive your unit.

A clear indicator of potential damage is a damaged shipping container. Please inspect the exterior of the shipping
container(s) to assess any damage. If damage is apparent, we recommend you keep the shipping container and all materials
until the unit is checked out electronically and mechanically. If damage has occurred, we recommend you contact your
shipping agent and Tektronix as soon as possible to report the situation.

The items that were shipped to you include:

BitAlyzer Instrument

Power Cord

USB Keyboard

USB Mouse

Registration Card

Quick Start User Manual

If the shipping container contents are not complete, please notify Tektronix immediately. Other items may be shipped with
your unit depending on optional configurations.

Calibration

Annual factory calibration is recommended for this equipment. Contact Technical Support to arrange for factory calibration.

Maintenance and Cleaning

Contact Tektronix Service.

Operating Requirements
Place the instrument on a cart or bench. The instrument should rest on its bottom.

Observe the following clearance requirements and dimensions:

Top: 0 in (0 cm)

Left and right side: 7.6 cm (3 in)

Bottom: 0 cm (0 in) standing on feet, flip stands down

Rear: 7.6 cm (3 in)

Before operating the instrument, verify that the ambient temperature is within the specified range: +5°C to +40°C (+41°F
to +104°F).
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Installation

Preventing ESD

CAUTION. A direct electrostatic discharge can damage the instrument input. To learn how to avoid this damage, read
the following information.

Electrostatic discharge (ESD) is a concern when handling any electronic equipment. The instrument is designed with
robust ESD protection; however it is still possible that large discharges of static electricity directly into the signal input
may damage the instrument. To avoid damage to the instrument, use the following techniques to prevent electrostatic
discharge to the instrument:

Discharge the static voltage from your body by wearing a grounded antistatic wrist strap while connecting and
disconnecting cables and adapters. The instrument provides a front panel connection for this purpose.

A cable that is left unconnected on a bench can develop a large static charge. Discharge the static voltage from all
cables before connecting them to the instrument or device under test by momentarily grounding the center conductor of
the cable, or by connecting a 50 Ω termination to one end, prior to attaching the cable to the instrument.

Connections
Connect Peripherals

The BitAlyzer Analyzer supports both a mouse and a keyboard in addition to the touch screen.

If you plan to use a mouse and/or keyboard, connect them to any open USB port on the Analyzer before turning on the power.

The Line Power plug and connectors for ground, network, monitor, Com1, and IEEE-488 (remote control) are on the rear
panel, as well as four USB 2.0 ports.

Clock and Data Connectors

The BitAlyzer Generator uses either an internal clock or an optional external clock source. The Clock connectors are on the
front panel. 50 Ω SMA cables and connectors are recommended.

A ground connector is provided at the lower left of the front panel.
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Installation

The connectors for the Data Generator and Error Detector are color-coded for easy identification; blue for the Generator
and green for the Detector.

Generator (Blue) Detector (Green)

Clock+ Out Clock+ In

Clock- Out Clock- In

Data+ Out Data+ In

Data- Out Data- In

External Clock In Start Detect In

Pattern Start In Marker (TTL Level) In

Page Select (TTL Level) In Blank (TTL Level) In

Trigger Out Error Out

Trigger Out
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Installation

Power On
1. The line power connector is located on the rear panel. Use the included power cord to connect the instrument to a

suitable AC supply.

2. Press the power button on the front panel to turn the instrument on. A green LED lights when the power is on.

The BitAlyzer performs a Self Test at startup. This takes a few minutes, and may report errors if the computer or any of its
peripherals are damaged. If the keyboard is not plugged in, the operating system will report that the driver did not initialize
properly. A keyboard is not necessary and you can ignore this reported error if you do not plan to use one.

If any damage is indicated, contact Technical Support.

With self test successfully completed, the operating system loads.

To power-down the unit, first allow the operating system to perform its shutdown procedures completely. To do so, touch the
Shutdown button on the Control Console. The screen will display a dialog asking if you wish to terminate only the BitAlyzer
application or shut down the entire system.

In the event of power failure or accidental power disconnect, the unit is very resilient. You may find that the next time you
power on, the boot-up sequence takes a few moments longer to verify the hard disk file system integrity.
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Operation

Display Description
The screen is touch-sensitive. Make selections and settings by touching the onscreen icons, or if you prefer, use a
mouse and/or keyboard.

The Control Console is on the right side of the touch screen. At the bottom of the screen, a Status Bar shows the state of the
Generator and Detector, BER statistics, and signal source. The center of the screen will show the selected view.

The Control Console and Status Bar remain visible from all views.

Touch the View button on the Control Console to navigate between views.

The Generator and Detector Views are presented as a schematic of the generation and detection process. Touching an
icon on the screen accesses settings and help for that element. For example, touch the Detector Delay icon to open the
popup menu, make settings, and access help.

Error Analysis Views

In addition to a graphic chart display, analysis views include responsive sections for setting analysis parameters and
controlling the appearance of a view:
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Setup buttons at the top of the screen

The violet Histogram Information Panel below the chart

The Analysis Console (normally hidden to allow more room for the chart display)

Physical Layer Tests

Physical Test views include zoom and pan buttons to navigate the chart, and one or more Sidebar panels with access to
measurements, controls, and display options related to the open view.
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Generator Fundamentals
Errors are found by sending a controlled bit stream into a channel and then performing a bit-for-bit compare on what comes
out of the channel. The Generator provides this controlled data stream, using either industry common pseudo-random
sequences or a user-defined pattern. The data stream is synchronized to either an internal or an external clock, and both
data and clock are then passed to the Detector.

Available Settings

Open the Generator View to explore settings. Each icon on the Generator view opens a menu of its associated parameters.
Select a data type, the characteristics of input and output data and clock signals, whether to inject errors into the data
stream, and the characteristics of those errors. The popup menus for these selections also provide direct access
to context-sensitive Help.

Data Patterns

The Generator uses two types of patterns; either a selection of pseudo-random sequences defined by a generating
polynomial (PRBS), or a user-defined pattern. The user pattern may be a prerecorded file of error information, or a file
created using a Pattern Generation Language (PATLING) to embody particular features.

Creating a Pattern

The Online Help available on your instrument describes the PATLING pattern generation language that can be used to create
error data files matching specific criteria for testing. You can also create a pattern by capturing data from the Detector inputs.

Live Signal Generation

Touch the icons on the Generator view to set the characteristics of a generated signal.
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Detector Fundamentals
The BitAlyzer Error Detector and Analyzer investigates error statistics present in digital channels. Errors are mismatches
between what was expected to be seen and what actually was seen during detection. By comparing a specific, known
pattern bit-by-bit with what is detected on the incoming channel, the Detector cannot only count errors, but can pinpoint the
exact position of errors in the digital channel.

This error location information provides more than just bit error rate testing. Using the exact bit location of errors found in the
data stream, the BitAlyzer measures independent bit and burst error statistics, correlates errors to reveal pattern sensitivities,
displays the probability of having error bursts of different lengths, isolates systematic error sources, and much more,
clarifying error relationships in addition to error counts. The varied types of analysis can reveal previously undetermined
idiosyncrasies of a data channel.

Available Settings

Open the Detector View to access the settings. Icons on the Detector view open menus of associated parameters. Select the
characteristics of input data and clock signals, delay, data patterns, and synchronization parameters. The popup menus for
these selections also provide direct access to context-sensitive Help.

Selecting the Analysis Type

Touch the View button to open the popup menu of the available views. Touch Error Analysis or Physical Layer Test and
choose a view from these lists. Error Analysis Views include: Basic BER, Block Errors, Burst Length, Correlation, Error
Free Interval, Pattern Sensitivity, Strip Chart, and optional views such as FEC Emulation and 2D Error Map. Physical Layer
Tests include Eye Diagram, BER Contour, Mask Test, Jitter Peak, and Q-Factor.

Setting Up a View

The Error Analysis views show an Analysis Engine icon at the bottom left corner that opens an Analysis Console where
most parameters are set or changed. Each view allows access to its appropriate settings; certain universal settings affect all
views, but can be changed as often as necessary. Touch the violet Histogram Information Panel to set the histogram chart
range and resolution. The settings are described below under “Important Settings.”

Saving and Playing Back an Error Data File

Open the Editor view to open, name, rename, save, or delete an error data file.

To create a file, select View > Error Analysis > Basic BER (or other type of Error Analysis) > Analysis Engine > Error
File > Record File > (enter a filename in the file selection dialog) > Run to start a session to be saved. Touch Run again
to stop the session.

To play back a file: beginning from any Error Analysis view, touch Analysis Engine > Play from File > (select filename) >
Open. The file will then play back automatically and results will be reflected in all Error Analysis histograms.

Loading a User Pattern. To load a pattern into the Detector RAM, select View > Detector > Error Detector > User
Pattern Mode > (select filename) > Open.

Graph Options. Touch the Chart Setup button at the top of the display, and then touch selections on the popup menu to
control the appearance of a graph. The menu allows you to enable and select cursors, graticule, and log scale.
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Important Settings to Define Analysis
Integration Period

The Integration Period is used when calculating error rates. Before dividing the number of errors by the number of bits, you
must first wait until enough bits are generated for the division result to have significance. For instance, if you have an error rate
of one error in 1e2 (100) bits, unless you wait 1e2 bits before dividing, you will probably get zero as a division result. In this
case, you would want to wait at least 1e4 (10,000) bits before dividing so there are two significant digits in the division result.

If your integration period is too long, you may wait quite a while before getting an error rate measurement. If it's too short, you
may get "jumpy" error rate measurements. A good rule of thumb is to take the expected error rate, change the sign of the
exponent, and add two to the exponent. An expected error rate of 1e-6 translates to an integration period of 1e8.

Burst error identification is reset upon integration period boundaries.

Burst Minimum Length

The Burst Minimum Length parameter is used to distinguish errors as either being part of a burst or not. Errors that are not
part of bursts are known as bit errors; these are the small, often random, errors.

During basic error analysis, single bit errors are grouped together using the Burst Error Free Threshold definition described
below. The resulting group is assigned a group length, which is defined to start at the first error of the group and end at
the last error (surrounding error free segments that are larger than the threshold are not included in the burst length).
This length is then compared to the Burst Minimum Length parameter and the group is handled either as a burst or as
bits, depending on the outcome.

By incrementing the Burst Minimum Length parameter, you specify that fewer and fewer error groups should qualify as bursts.

Burst Error Free Threshold

Burst errors are characterized as groups of single bit errors that are adjacent to one another. The Burst Error Free Threshold
parameter is used to program the degree of adjacency that is required to group single bit errors together to form bursts. An
error free segment that exceeds the threshold terminates a burst, and all bursts are surrounded by error free segments
that exceed the threshold.

Changing the Burst Error Free Threshold will change the shape of your burst length profiles because it changes the
specification of a burst.

Data Block Size

A Block is a contiguous number of bits for which an error count is calculated. This is useful for channel error correction
analysis. In some cases, error correction block sizes are fixed due to pre-existing packet frame sizes, sector sizes, or
similar system characteristics. If you set the Block definition to a matching size, the Block histogram will show you a profile
of how many errors occur in all the blocks. The shape of this curve will determine an effective value for the trade-off
between error correction strength and coding overhead.

Histogram Data Range

Each histogram view has a Setup button at the top edge. Touch this button to open a setup dialog that sets the Start and End
x-values for the currently displayed histogram. These limits define the range of data that will be analyzed.

Changing these values will clear out any existing data in the histogram. The Start value must be zero or greater, and
less than the End value.
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Histogram Bin Mapping. The concept of mapping error positions to histogram bins is important to understanding error
location analysis. A histogram bin is a software data structure that is used for every histogram to maintain information. There
is a limit of 1,000 unique histogram locations that can be maintained by the BitAlyzer. After this limit is exceeded, then
histogram locations are mapped two bit locations to one bin, and then three-to-one, four-to-one, and so on. This allows you
to trade off histogram resolution for range.

For a Histogram Range [Start, End], the Start value is inclusive and the End value is exclusive. For example, if the range
is specified as [0,1000], then 1,000 bins are established, from Bin 0 to Bin 999. The bin resolution is one. Bin 0 contains
data [–∞, 1] and Bin 999 contains [999, +∞]. When the range is 1,001 or greater, the bin resolution will be two or more,
as necessary to include all data within the available bins.

If you need both a large range and detailed resolution, you may have to perform the analysis in multiple steps. For example,
to see error correlation to a block size of one million bits, set Start to 0 (zero) and End to 1,000,000 to view the overall result.
With this range, each bin in the resulting correlation histogram represents hundreds of correlation bit positions. Once a
correlation is found at one bin location, you can refine the Start and End points to effectively redirect all the histogram bin
resolution to the one bin of interest. With new settings, each individual bit position can be uniquely resolved.
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How to Use the BitAlyzer Analyzer

The following examples introduce the basic operation of the BA1500 and BA1600. Example 1 steps through configuration of
the Generator and Detector in a way that allows easy confirmation of correct E-to-E operation. Example 2 steps through the
setup for several Error Location Analysis views, and Example 3 introduces the Eye Diagram.

Example 1: Configure Pattern Generator and Error Detector
Use four cables to connect the Generator Clock+/− and Data+/− outputs to the Detector Clock+/− and Data+/− inputs on the
front panel. Then, to verify that the Generator and Detector are operating correctly, make the following settings.

Generator Setup

In a few steps, we will set the Generator to output PRBS-7 data at a specified data rate using differential CML voltage levels.

Set External Clock Frequency. View > Generator > SYNTHESIZER > Use Keypad > 500 MHz > OK

1. Touch View on the Control Console, and select Generator.

2. Touch the SYNTHESIZER input icon on the Generator view to open the Internal Clock input settings dialog.
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3. Touch Use Keypad on the dialog, and

4. Enter 500 MHz using the popup keypad, then touch OK.

5. Verify that the clock rate on the display matches the 500 MHz frequency.

Set Data Type to PRBS-7.

Generator > GENERATOR > Pattern > PRBS-7

1. Touch the GENERATOR button in the center of the view to open the Generator settings dialog.

2. Touch Pattern, and

3. Select PRBS-7 from the popup list.
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Set Output Logic Family to CML. Generator > CLOCK+ > Link Clock+/−

CLOCK+ > Logic Family > CML

1. Make sure Link Clock +/− Signals is checked.

2. Touch the CLOCK+ icon to open the Clock output settings dialog.

3. Touch Logic Family on the dialog, and

4. Touch CML on the popup list.

5. Repeat the same steps beginning with the DATA+ output icon.

6. Touch the Outputs On/Off button at the top of the display to enable the Clock and Data outputs.

The Pattern Generator is now transmitting PRBS-7 data at 500 Mbit/sec on differential clock and data outputs set to industry
standard CML levels.

Detector Setup

Next, we will set up the Detector to accept differential CML signals and make a bit error rate measurement.

Set Detector Interface Mode and Logic Family. View > Detector > CLOCK > Interface Mode > Differential
View > Detector > CLOCK > Logic Family > CML

1. Touch View and select Detector.

2. On the Detector view, touch the CLOCK input icon to open the settings dialog.

3. Touch Interface Mode.

4. Touch Differential on the popup list.
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5. Touch CLOCK again.

6. Touch Logic Family on the dialog.

7. Touch CML on the popup list.

8. Touch CLOCK again, then Optimize Threshold. The optimum threshold will be automatically set.

9. In the same way, set the Data input interface mode and logic family:

Touch DATA > Interface Mode > Differential

Touch DATA > Logic Family > CML

Set Detector Data Type to Automatic Pattern Detect.

Detector > ERROR DETECTOR > Auto Pattern

1. Touch the ERROR DETECTOR icon.

2. Select Auto Pattern from the popup list. This enables the Detector to compare all known PRBS data patterns when
acquiring synchronization.

3. Touch Auto Align to optimize the data measurement point with the incoming data signal. This moves the delay timing and
voltage threshold to find the best sampling point in the received eye for making BER measurements.
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You may be asked to recalibrate the delay element when you touch Auto Align. The instrument monitors changes in data
frequency and temperature and can automatically recalibrate its built-in variable delay element in less than one second.

4. Verify the data pattern type and data rate for both the Generator and Detector, displayed on the Status Bar at the
bottom of the screen.

If Synchronization Is Not Achieved
If the Generator and Detector are not in sync, this situation must remedied before going on. There are certain things
that can cause a no-sync condition:

1. Carefully examine cable connections and polarity, making any corrections needed.

Examine the Generator and Detector views to determine:

2. Status Bar indicates Sync. When sync is achieved, the status bar will show the data type and data rate for both the
Generator and Detector. Otherwise, the bar will be bright yellow, displaying a “No Sync” error message.

3. Data Type is PRBS-7. If not:

Check for correct Data Type setting on the Generator and, if necessary, reset to PRBS-7.

Check for correct Data Type setting on the Detector and, if necessary, reset to Auto Detect.

4. Generator Clock Rate is 500 MHz. If not:

Check for correct Generator Clock setting. If necessary, reset to 500 MHz.

Optimize the Detector Clock Threshold (View > Detector > CLOCK > Optimize Threshold).

5. Clock +/− and Data +/− output and input Logic Family configurations match. If not:

Check Logic Family configurations (both Logic Type and single-ended/differential mode) for the Generator External
Clock, Clock+/− outputs, and Data+/− outputs. If necessary, set to the same configuration as the Detector inputs.

Check Logic Family configurations for the Detector Clock and Data inputs. If necessary, set to the same configuration
as the Generator outputs.

6. Retry for synchronization.
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Reset to Zero
Reset BER and Resyncs to Zero

Run > Run > Reset Results

1. Touch Run on the Control Console; then touch a second time to stop.

2. Touch the Reset Results button at the top of the screen.

Verify Zero BER/Zero Resyncs

3. Verify that the Detector is showing a data type of PRBS-7

4. The input clock rate matches the 500 MHz rate being transmitted by the Generator

5. The Detector Results box indicates zero BER and zero resyncs
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Example 2: Perform Error Location Analysis
This introduction to Error Location Analysis gives three examples from the available analysis types. Our goal is to turn on
the error injector for 32-bit bursts at the default interval of 312,512 bits, then measure the bit and burst error rates using
the Basic BER View, the Burst Length profile (you should see a spike at 32 bits), and then the Error Free Interval profile
(you should see a spike at error free intervals of 312,480).

Following these step-by-step processes will familiarize you with most of parameters, settings, and controls involved in using
the BitAlyzer. After completing the lesson, you will be able to make use of Error Location Analysis without difficulty.

Set Up a Test Case

Open the Generator view.

Enable Error Injection. Generator > ERROR INJECT

Let’s generate some error bursts, to see what shows up on the analysis histograms. By enabling the Error Injector in the
Generator, you can set a specific burst error length and interval, and then observe exactly what the Detector finds.

Generator > ERROR INJECT > Mode > Continuous

Touch either the Control Console View button or the Generator field in the Status Bar to open the Generator view.

Touch the ERROR INJECT button.

Touch Mode, then select Continuous from the popup list.

Generator > ERROR INJECT > Type > 32Bit Burst
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Touch ERROR INJECT again, touch Type, and select 32-Bit Burst.

Generator > ERROR INJECT > Interval > Default (312,512 bits)

Touch ERROR INJECT and check the value displayed as Interval (the number of bits between error injections). The
default value is 312,512 bits. If a different interval is displayed, touch Interval and select Default on the popup dialog
to reset the default interval of 312,512 bits.

Select the Analysis View

View > Error Analysis > Basic BER

Choose the Parameters

For this test case, we are using the Default settings.
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Basic BER > Setup > Enable Analysis

Basic BER > Set Default > This Analyzer

NOTE. For our test case, we will leave all of these parameters at their default settings.

Basic BER Data

This selection will analyze live data transmission from a Generator.

Basic BER > Run

Touch Run on the Control Console.

Basic error statistics are shown in the Basic BER view, along with the current settings for several important measurement
parameters:

Total Bits

Total Errors (Burst Related and Non-Burst Related)

Total Bit Error Rate (Burst Related and Non-Burst Related)

Burst Events

Markers
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Pattern

Starting Mode

Burst Minimum Length

Burst Error Free Threshold

Integration Period

BER calculations depend upon the values for Burst Minimum Length, Burst Error Free Threshold, and Integration Period.

Because we have set a Burst Length of 32 bits injected every 312,512 bits, and left Burst Error Free Threshold and
Integration Period at their default settings (32 bits and 1.00E+09 bits, respectively), the error rates can be predicted:

1. A Burst Related Error Rate of 1.02E-04

2. A Non-Burst Related Error Rate of 0.00E+00 (zero), and

3. A Total Error Rate equaling the Burst Related Error Rate

Note that the Basic BER view does indeed show these measurements.

Select Burst Length View

View > Error Analysis > Burst Length

Burst Length Parameters

Using the same parameters already set (a 32-bit error injected into the PRBS-7 pattern every 312,512 bits), you would expect
to see an error burst length corresponding to the 32 bits of the injected error.

Burst Length Data

This selection will analyze live data transmission from a Generator.

Make sure that the Detector is in Run mode.
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As expected, you can clearly see the spike of error bursts on the histogram. To verify the length of 32 bits, zoom in on the
spike.

Touch the Zoom button below the chart, then touch anywhere inside the histogram chart and drag to zoom. To pan, touch the
pan button, and then touch and drag on the chart. You can also show cursors by touching Chart Setup and selecting the
cursor(s) you want displayed. To position a cursor, touch its “handle” (the box showing its position), then drag it into place.

Once you have zoomed in on the data, you can see that the spike of bursts in the data is at a length of 32 bits.
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Select Error Free Interval View

View > Error Analysis > Error Free Interval

Error Free Interval Parameters

Using the parameters already set (a 32-bit error injected into the PRBS-7 pattern every 312,512 bits), you would expect to
see an error free interval corresponding to that 312,512 number:

[(312,512-bit interval) – (32-bit burst error)] = 312,480-bit Error Free Interval

Error Free Interval Data

This selection will analyze live data transmission from a Generator.
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Detector > Run > Auto Center

1. Make sure that the Detector is in Run mode.

2. Touch Auto Center to scale the chart to fit the data, or touch anywhere inside the histogram chart and drag your finger to
the left to zoom out so that the anticipated range of data is visible.

There is an obvious spike in the vicinity of 300,000. To verify the precise location, the next section will explain how to adjust
the histogram range and resolution to see an exact bit-for-bit representation of the EFI.

Adjust Histogram Range and Resolution

Basic BER > Information Panel > Hist Start/Hist End/Hist Resolution

Once you have seen the “rough” data, you can change the histogram range to get one-bit resolutions and show the exact
error free interval value. Each histogram contains 1,000 bins, each representing 1/1000 of the data contained in the
histogram range. By adjusting the range start and end values, you can narrow the parameters until the chart reveals
the precise location of your data.

1. Touch anywhere on the violet Information Panel to open the Histogram Settings dialog.

2. Touch Hist Start. In this case, we know where the interval should appear, so we can shortcut the trial-and-error method.
Enter 312,450 bits using the keypad, and touch OK.

3. Touch Hist End and enter 312,550 bits.

4. If the Resolution does not already show “1” touch Hist Resolution and enter 1.

The EFI chart will zoom in precisely on the range specified.
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Another way to get an exact bit count is to use the chart cursors:

1. Touch Chart Setup and

2. Enable the Bits cursors.

3. Touch a cursor label and drag the cursor onto the spike. The cursor label will display its exact bit location, thus verifying
the Error Free Interval of 312,480 bits.

Example 3: Eye Diagram
Select the Eye Diagram View

View > Physical Layer Test > Eye Diagram

Choose Eye Diagram Parameters

Set up the Eye Diagram to show the areas of most interest:
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View > Physical Layer Test > Eye Diagram > Eye Setup

1. Touch the Eye Setup button at the top of the display.

2. From the popup menu, select cursors, set persistence, and select whether to measure edges at 80–20% or 90–10%.
(Other than turning on the cursors, you can leave these settings at their defaults for the purpose of our illustration.)

3. Touch Run on the Control Console.

View Eye Diagram

Display all of the data on one screen.

BitAlyzer Quick Start User Manual 25



How to Use the BitAlyzer Analyzer

Eye Diagram > Auto Center > Zoom/Pan

1. Touch Auto Center at the top of the screen, to scale the chart so that a complete eye is seen.

Examine your data more closely:

Zoom and pan to see more detail:

1. Touch the Vertical Zoom button at the left edge of the chart. Touch the display and drag up, or turn the front panel
knob clockwise.

2. Touch Horizontal Pan at the bottom of the chart. Touch the display and drag down, or turn the front panel knob
counter-clockwise.

Make Eye Measurements

Use the cursors to make measurements.
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Touch a cursor “handle” (the measurement box) and drag the cursor into position to measure a feature of the eye. The
measurement shown in the box will update automatically.

Or use the Measurement Sidebar:

1. Touch the Measure button at the lower left of the screen to open the Measurement Sidebar. Touch a labeled button to
enable that measurement. The selected measurement will remain visible on the eye diagram if the Sidebar is closed.

2. In the illustration, green arrows indicate measurement of the Eye Width at 1.977 picoseconds.
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Conclusion
To learn more about your BitAlyzer, visit the Error Location Analysis section of the Help system on your unit. This help
topic includes a tutorial to introduce the diagnostic creativity of the patented Error Location Analysis process. You will find
a link to Error Location Analysis on the Help Home view, or touch Error Location in the Analysis Console, and then
Help on Error Analysis.
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Operating System Restore

The BitAlyzer Analyzer contains an operating system restore file in a separate folder on the hard drive. Use this file to restore
the instrument operating system.

CAUTION. Using the restore process reformats the hard drive and reinstalls the operating system. All saved data is lost. If
possible, save important files to external media before performing a system restore.

1. Restart the instrument. During the boot-up process you will see the following message at the top of the screen: Acronis
Loader…. Press F5 on the keyboard to start the Acronis Startup Recovery Manager.

2. Repeatedly press the F5 key until the Acronis True Image Tool opens. There is a 15-second delay after the message
appears until the instrument proceeds with normal instrument startup. If the instrument does not open the Acronis
application, power off the instrument, then power on the instrument and try again.

3. Touch Restore.

4. In the Confirmation dialog box, touch Yes to restore the instrument operating system, or No to exit the restore process.
The restore process takes approximately 30 minutes; the actual time depends on the instrument configuration.

NOTE. The System Restore process includes reinstallation of the BitAlyzer application at the revision level installed
on your instrument at the factory. A later version of the application software may be available. For access to the latest
software, check the Tektronix Web site at www.tektronix.com/software and follow the instructions to download the latest
software for your instrument.
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Specifications

Specifications are subject to change.

User Interface 640 x 480 Active Matrix TFT color display
High resolution analog resistive touch screen

Processor 1.66 GHz Atom N455
1 GByte DRAM
160 GB Hard Drive

Operating System Microsoft Windows 7

USB Four USB-A connectors on rear panel

Com1 D-sub 9

Remote Control Interface IEEE-488
Ethernet Remote Control via TCP/IP

Network Interface 1 GB Ethernet

Size Height: 8.6 in (21.8 cm)
Width: 16.5 in (41.9 cm)
Depth: 17.5 in (44.5 cm)

Weight <36 lb (<16.3 kg), unpackaged

Power 285 watt
100-240 VAC ±10%
50/60 Hz

Power Fuse 3.15 A, 250 V, 5 mm x 20 mm, fast blow

Operating: +5°C to +40°C, with 11°C/hour maximum gradient,
non-condensing, derated 1.0°C per 300 meters above
1,500 meters altitude

Temperature

Non-Operating: −20°C to +60°C, with 20°C/hour maximum gradient, without disk
media installed in disk drive

Operating: 8% to 80% relative humidity (% RH) up to +32°C
5% to 45% RH above +32°C up to +45°C
Non-condensing, and as limited by a Maximum Wet Bulb
Temperature of +29.4°C (derates relative humidity to 32% RH at
+45°C)

Humidity

Non-Operating: 5% to 95% relative humidity (% RH) up to +30°C
5% to 45% RH above +30°C up to +60°C
Non-condensing, and as limited by a Maximum Wet Bulb
Temperature of +29.4°C (derates relative humidity to 11% RH at
+60°C)

Operating: Up to 2,000 meters (derate maximum operating temperature by
1°C per 300 meters above 1,500 meters altitude)

Altitude

Non-Operating: Up to 12,000 meters
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